
92 ELEKTRONIKA PRAKTYCZNA 6/2013

Krok po kroku K
u
rsy E

P

Dodatkowe materiały na CD/FTP:
ftp://ep.com.pl, user: 63241, pass: 741obq51

MSP430 w przykładach (10)

W tym artykule – kończącym cykl kursu programowania MSP430 – omówimy obsługę 
wewnętrznej pamięci Flash mikrokontrolera. Zaprezentujemy projekt zamka cyfro-
wego z pastylką cyfrową fi rmy Maxim-Dallas – DS19990A. Kurs zakończymy, krótkim 
podsumowaniem.

Obsługa wewnętrznej pamięci Flash

segmenty A  i B. Pamięć kodu programu tworzy 16 seg-
mentów. Każdy segment pamięci jest zbudowany z blo-
ków pamięci o  rozmiarze 64 bajtów. Segmenty A  i  B 
pamięci informacyjnej zbudowane są z  dwóch bloków 
pamięci (rozmiar segmentu pamięci informacyjnej to128 
bajtów). Segmenty 0…15 pamięci kodu programu zbudo-
wane są z 8 bloków pamięci (rozmiar segmentu pamię-
ci kodu programu to 512 bajtów). Segmentację pamięci 
w MSP430f1232 pokazano na rysunku 2.

Kontroler pamięci
Mikrokontroler MSP430f1232 ma wewnętrzny kontroler 
pamięci Flash. Kontroler jest używany podczas operacji 
kasowania i programowania pamięci. W  strukturę kon-
trolera wbudowano generator taktujący oraz generator 
napięcia. Budowę kontrolera ilustruje rysunek 3.

Kontroler pamięci Flash jest konfi gurowany za pomo-
cą 16-bitowych rejestrów: FCTL1, FCTL2, FCTL3. Opis 
rejestrów zamieszczono w materiałach dodatkowych na 
CD oraz na serwerze FTP. Dostęp do rejestrów konfi gu-
racyjnych jest chroniony hasłem. W przypadku zapisu 
do rejestrów bez podania hasła, bądź z błędnym hasłem 
w rejestrze FCTL3, jest ustawiana fl aga KEYV oraz wyko-
nany restart PUC mikrokontrolera. Hasło dostępu do reje-
strów konfi guracyjnych ma wartość 0x5A (w środowisku 
IAR defi nicja FWKEY). Hasło wpisujemy do bardziej zna-
czącego bajtu rejestru. Podczas odczytu rejestru bardziej 
znaczący bajt ma zawsze wartość 0x69, mniej znaczący 
ilustruje ustawienie bitów konfi guracyjnych. 

Mikrokontroler MSP430f1232, zainstalowany w mo-
dule „Komputerek”, wyposażono w 8 kB+256 B pamięci 
Flash. W  procesorze dostępne są dwa rodzaje pamięci 
Flash: pamięć kodu programu (Code Memory, 8 kB), oraz 
pamięć informacyjna (Info Memory, 256 B). Oba rodzaje 
pamięci różnią się maksymalną liczbą cykli kasowania. 
Pamięć kodu programu (Code Memory) ma gwaranto-
wane 10 tysięcy cykli kasowania. Pamięć informacyjna 
jest trwalsza i ma gwarantowane 100 tysięcy cykli ka-
sowania. Po przekroczeniu maksymalnej, zdefi niowanej 
liczby cykli kasowania, pamięć może ulec uszkodzeniu. 
Dlatego też, to trwalsza pamięć informacyjna powinna 
być używana do przechowywania danych konfi guracji 
urządzenia.

Mikrokontrolery MSP430, w  tym również 
MSP430f1232, mają architekturę von Neumanna (jedna 
pamięć danych i instrukcji, ciągła przestrzeń adresowa). 
Podstawowym słowem pamięci jest bajt. Dane o większej 
ilości bajtów zapisywane są w  formacie „little endian”. 
Dostęp do pamięci (odczyt/zapis) możliwy jest za pomo-
cą bitów, bajtów (8 bitów), oraz słów (16 bitów). Mapę 
przestrzeni adresowej mikrokontrolera MSP430f1232 po-
kazano na rysunku 1. 

Pamięć Flash mikrokontrolera MSP430f1232 po-
dzielono na segmenty. Pamięć informacyjną tworzą dwa 

Rysunek 1. Przestrzeń adresowa mikrokontrolera 
MSP430f1232 Rysunek 2. Segmentacja pamięci w MSP430f1232
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być zasilany napięciem o wartości powyżej 2,7 V! W mi-
krokontrolerach MSP430 z serii 2xx napięcie zmniejszo-
no do 2,2 V, a w najnowszych układach z serii 5xx/6xx 
do 1,8 V. Jeśli napięcie zasilania mikrokontrolera będzie 
poniżej wartości 2,7 V, generator nie będzie działał po-
prawnie, a podczas kasowania i programowania pamięci 
Flash mogą wystąpić błędy.

Zabezpieczenia
Dostęp do rejestrów konfi guracyjnych kontrolera pamięci 
Flash jest chroniony hasłem. Dodatkowo, operacje zapisu 
i kasowania pamięci również zostały zabezpieczone (bit 
LOCK w rejestrze FCTL3). Aby kontroler pamięci Flash 
mógł zapisywać i kasować pamięć, bit LOCK musi być 
wyzerowany. Ustawiony bit blokuje dostęp do obu opera-
cji. Pracując z kontrolerem pamięci Flash należy również 
pamiętać, że operacje zapisu do rejestrów konfi guracyj-
nych oraz kasowania i  programowania pamięci Flash 
nie mogą zostać przerwane. Dlatego też, na czas pracy 
z kontrolerem pamięci, należy wyłączyć przerwania ma-

Kod programu steru-
jącego pracą mikrokon-
trolera można umieścić 
albo w  pamięci SRAM, 
albo Flash układu. 
W praktyce w 99 % przy-
padków oprogramowanie 
jest wgrywane do pa-
mięci Flash. W  artykule 
omówimy sposób obsługi 
kontrolera pamięci Flash 
w  przypadku, gdy jest 
do niej wgrany program. 
Marginalny przypadek 
z programem w pamięci 
SRAM nie będzie dysku-
towany.

Generator 
taktujący
W moduł kontrolera pamięci Flash wbudowano gene-
rator taktujący. Wytwarza on sygnał Fftg używany do 
taktowania operacji kasowania i programowania pamięci 
Flash mikrokontrolera. Sygnał Fftg jest wytwarzany na 
podstawie jednego z sygnałów zegarowych mikrokontro-
lera: ACLK, MCLK, SMCLK. Źródło sygnału zegarowego 
konfi guruje bit FSSELx z  rejestru FCTL2. Aby kontroler 
pamięci działał poprawnie, to częstotliwość sygnału Fftg 
musi być z przedziału 257…476 kHz. Jeśli częstotliwość 
sygnału wejściowego (sygnał zegarowy: ACLK/MCLK/
SMCLK) jest zbyt wysoka, to należy ją podzielić. Dziel-
nik częstotliwości konfi gurują bity FNx z rejestru FCTL2. 
Wartość dzielnika obliczamy ze wzoru 10.1. Minimalna 
wartość dzielnika wynosi 1, maksymalna 64.
(10.1)

fdiv=32×FN5+16×FN4+8×FN3
+4×FN2+2×FN1+1×FN0+1

gdzie:
  fdiv – dzielnik częstotliwości sygnału zegarowego.
  FN5…0 – bity konfi guracyjne FNx z rejestru FCTL2.

Generator 
napięcia
Moduł kontrolera 
pamięci Flash wy-
posażono w  ge-
nerator napięcia. 
Wytwarza on 
podwyższone na-
pięcie elektrycz-
ne używane pod-
czas kasowania 
i  programowania 
pamięci. Genera-
tor jest włączany 
automatycznie 
na czas operacji 
kasowania i  pro-
gramowania pa-
mięci. Aby moduł 
generatora napię-
cia działał prawi-
dłowo, nasz mi-
krokontroler musi 

Rysunek 3. Schemat blokowy kontrolera pamięci Flash

Rysunek 4. Schemat blokowy procedury a) kasowania segmentu pamięci b) zapisu do 
pamięci
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pamięci Flash pokazano na listingu 1. Schemat blokowy 
procedury ilustruje rysunek 4a.

Kasowanie segmentu pamięci Flash w MSP430f1232 
trwa 4819 taktów przebiegu Fftg. Kasowanie całej pamię-
ci programu, plus ewentualne kasowanie pamięci infor-
macyjnej, trwa 5297 taktów Fftg. W  trakcie kasowania 
pamięci pobór prądu mikrokontrolera wynosi 3…7 mA.

Zapis do pamięci
Zapisując dane do pamięci Flash zawsze istnieje możli-
wość wyzerowania bitu pamięci, nigdy jego ustawienia 
(zmiana z 0 na 1). Aby ustawić bit pamięci, należy ją ska-
sować. Dlatego też, w wielu aplikacjach, zapis do pamię-
ci jest poprzedzany jej kasowaniem.

Dane do pamięci mogą być zapisywane jako bity, baj-
ty lub słowa. Mogą być też zapisywane w formie bloków 
64-bajtowych. Tryb zapisu do pamięci konfi gurują bity 
BLKWRT, WRT z rejestru FCTL1. Zapis bloku pamięci nie 
jest obsługiwany, gdy program znajduje się w  pamięci 
Flash i nie będzie omawiany. Procedurę zapisu danych 
do pamięci Flash pokazano na listingu 2. Schemat bloko-
wy procedury ilustruje rysunek 4b. Zapis bajtu lub słowa 
do pamięci Flash w MSP430f1232 trwa 35 taktów Fftg. 
W  trakcie zapisu danych pobór prądu mikrokontrolera 
wynosi 3…5 mA.

Przykłady
Zaprezentujemy dwa przykłady obsługi kontrolera 

pamięci Flash w  MSP430f1232. Kody źródłowe progra-
mów oraz fi lmy ilustrujące ich działanie zamieszczono 
na płycie CD i serwerze FTP.

W  przykładzie „Obsługa pamięci Flash” zademon-
strujemy sposób użycia procedur obsługi kontrolera 
pamięci Flash (kasowanie pamięci/zapis danych do pa-
mięci/odczyt danych z  pamięci ). Działanie kontrolera 
pamięci przećwiczymy pracując z segmentem B pamięci 
informacyjnej mikrokontrolera.

W przykładzie „Zamek cyfrowy” obsłużymy odczyt 
pastylki identyfi kacyjnej Dallasa – DS19990A. Każda 
pastylka iButton ma unikalny, 48-bitowy numer seryj-
ny zapisany w pamięci ROM. Odczyt kodu pastylki jest 
możliwy za pomocą interfejsu 1-Wire. W programie raz 
na sekundę będziemy sprawdzali stan linii interfejsu 
1-Wire, a po wykryciu pastylki iButton będziemy odczy-
tywali jej kod. Odczytanego kodu pastylki użyjemy jako 
klucza cyfrowego do otwarcia zamku. W  przykładzie, 
naszym „zamkiem” będzie dioda LED koloru zielonego 
podłączona do linii wyjścia mikrokontrolera. Ustawienie 
na linii na czas 0,5 s stanu odpowiada zaświeceniu się 
diody i symuluje otwarcie zamka.

Program działa w dwóch trybach: programowania 
i  sterowania zamkiem. W  trybie programowania od-
czytany kod pastylki iButton jest zapisywany w  pa-
mięci Flash mikrokontrolera (programowanie klucza 
cyfrowego w pamięci Flash mikrokontrolera). W trybie 
sterowania zamkiem odczytany kod pastylki jest po-
równywany z kodem zapisanym w pamięci Flash mi-
krokontrolera. Jeśli oba kody są identyczne, to zamek 
jest otwierany.

Obsługa pamięci Flash
Program „Obsługa pamięci Flash” uruchamiamy korzy-
stając z modułu „Komputerek”. Wszystkie zworki układu 
należy ustawić w pozycji IO/Off. 

skowalne i niemaskwalne), oraz zatrzymać pracę układu 
Watchdog.

Kasowanie pamięci
Operacja kasowania pamięci Flash polega na ustawie-
niu bitów pamięci (zamazanie pamięci jedynkami). 
W MSP430 pamięć można kasować segmentami, można 
również od razu skasować całą pamięć kodu programu 
oraz dodatkowo, pamięć informacyjną. Jeśli program jest 
wgrany do pamięci SRAM, to pamięć Flash można ka-
sować blokami. Sposób kasowania pamięci konfi gurują 
bity ERASE i MERAS z rejestru FCTL1. Operacja kasowa-
nia wymaga „sztucznego” zapisu danych pod adres kaso-
wanego obszaru pamięci. Procedurę kasowania segmentu 

Listing 1. Procedura kasowania segmentu pamięci Flash
/* procedura kasowania segmentu pamięci Flash 
mikrokontrolera */
void FlashKasujSegment(char * adres)
{
  unsigned int  wdtctl;  // zmienne lokalne
  unsigned char ie1;  
// zapamiętaj konfi gurację
  wdtctl  = WDTCTL;  // układu Watchdog 
  ie1     = IE1;  // oraz przerwań niemaskowalnych
  WDTCTL =  WDTPW + WDTHOLD;  //zatrzymaj układ Watchdog 
Timer
  __bic_SR_register(GIE);  // zablokuj przerwania 
maskowalne
  IE1 &=~ (NMIIE + OFIE + ACCVIE);  // wyłącz przerwania 
niemaskowalne
// konfi guracja generatora taktującego   
// ustaw źródło SMCLK=DCOCLK~740 kHz
// podziel częst. SMCLK przez 2
//(~740 kHz/2)=~370 kHz jest w wymaganym zakresie 
256..476 kHz
  FCTL2 = FWKEY + FSSEL_3 + FN0;
  FCTL3 = FWKEY;  // odblokuj dostęp do pamięci (LOCK=0)   
  FCTL1 = FWKEY + ERASE;  // włącz kasowanie segmentu 
(ERASE=1)
  *adres = 0x00;  // sztuczny zapis,
  FCTL1 = FWKEY;  // wyłącz kasowanie segmentu (ERASE=0)
  FCTL3 = FWKEY + LOCK;  // zablokuj dostęp do pamięci 
(LOCK=1)
// przywróć konfi gurację
  wdtctl &= 0x00FF;  // wyzeruj hasło odczytu rej. WDTCTL
  wdtctl |= WDTPW;  // ustaw hasło zapisu rej. WDTCTL
  WDTCTL = wdtctl;  // ustaw konfi gurację uk. Watchdog
  __bis_SR_register(GIE);  // odblokuj przerwania 
maskowalne
    IE1    = ie1;  // przywróć konfi gurację źródeł 
przerwań 
}

Listing 2. Procedura zapisu do pamięci Flash
/* procedura zapisu danych do pamięci Flash 
mikrokontrolera */
void FlashZapisz(char* adres, char* dane, int ilosc)
{
  unsigned int  indeks;  // zmienne lokalne
  unsigned int  wdtctl;
  unsigned char ie1;
// zapamiętaj konfi gurację
  wdtctl = WDTCTL;  // układu Watchdog 
  ie1 = IE1;  // oraz przerwań „niemaskowalnych” 
  WDTCTL = WDTPW + WDTHOLD;  // zatrzymaj układ Watchdog 
Timer
  __bic_SR_register(GIE);  // zablokuj przerwania 
maskowalne
  IE1 &=~ (NMIIE + OFIE + ACCVIE);  // wyłącz przerwania 
niemaskowalne
// konfi guracja generatora taktującego 
// ustaw źródło SMCLK=DCOCLK= ~740 kHz i podziel częst. 
SMCLK przez 2
  FCTL2 = FWKEY + FSSEL_3 + FN0;
  FCTL3 = FWKEY;  // odblokuj dostęp do pamięci (LOCK=0)     
  FCTL1 = FWKEY + WRT;  // włącz zapis bajt/słowo (WRT=1)
  for(indeks=0; indeks < ilosc; indeks++)  // zapisz dane 
(bajtowo)
    *((char*)adres ++) = *((char*)dane ++);
  FCTL1 = FWKEY;  // wyłącz zapis bajt/słowo (WRT=0)
  FCTL3 = FWKEY + LOCK;  // zablokuj dostęp do pamięci 
(LOCK=1)
// przywróć ustawienia
  wdtctl &= 0x00FF;  // wyzeruj hasło odczytu rej. WDTCTL
  wdtctl |= WDTPW;  // ustaw hasło zapisu rej. WDTCTL
  WDTCTL =  wdtctl;  // ustaw konfi gurację uk. Watchdog
  __bis_SR_register(GIE);  // odblokuj przerwania 
maskowalne
  IE1    = ie1;  // przywróć ustawienia źródeł przerwań
}
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Działanie programu przeanalizujemy korzystając 
z  emulatora środowiska IAR. Uruchamiamy emulator 
(Project -> Download and Debug lub skrót klawiszowy 
Ctrl+D). W linii programu wskazanej w komentarzu usta-
wiamy pułapkę sprzętową (Edit -> Toggle Breakpoint lub 
klawisz F9). Następnie uruchamiamy program (Debug -> 
Go, klawisz F5). W programie jest zerowana zawartość 
bufora odczytu pamięci oraz kasowany segment B pamię-
ci informacyjnej mikrokontrolera. W pamięci Flash, pod 
adresem 0x1000 (początek segmentu B) jest zapisywany 
ciąg 7 znaków: „abcdefg”. Następnie, zawartość pamięci 
jest odczytywana do bufora odczytu (7 bajtów pamięci 
począwszy od adresu 0x1000). W kolejnej instrukcji dzia-
łanie programu jest zatrzymywane na pułapce sprzęto-
wej. W oknie podglądu zmiennych lokalnych programu 
(View -> Locals) możemy sprawdzić zawartość danych 
w buforze odczytu. Ewentualnie możemy podejrzeć za-
wartość pamięci Flash mikrokontrolera (View -> Memo-
ry). Jeśli w buforze odczytu i w pamięci mikrokontrolera 
jest ciąg znaków „abcdefg”, to programowanie pamięci 
wykonało się prawidłowo. Okna emulatora z włączonym 
podglądem zmiennych oraz zawartości pamięci Flash 
mikrokontrolera pokazano na rysunku 5.

Tabela 1. Programy prezentowane w  kolejnych artykułach cyklu
Nr Tytuł artykułu Opis Przykłady Publikacja

1 Wprowadzenie.
Budowa modułu „Kom-
puterek”. Właściwości  
MSP430f1232.

xxx EP09/2012

2 Konfi guracja układu 
zegarowego.

Działanie modułu 
zegarowego
Basic Clock. Przykłady 
konfi guracji układu 
zegarowego.

2.1 – Częstotliwości  sygnału DCOCLK. Pomiar częstotliwości 
sygnału DCOCLK.

EP10/2012
2.2 – Obsługa układu zegarowego. Przykłady konfi guracji 

układu zegarowego.

3 Projektowanie urządzeń 
“low power”.

Zasady projektowania 
urządzeń o  niskim 
poborze mocy. 
Tryby uśpienia LPMx 
w  MSP430.

xxx EP11/2012

4 Obsługa portów wej-
ścia/wyjścia.

Konfi guracja oraz 
sterowanie liniami we/
wy MSP430. 

4.1– Sterowanie diodą 
RGB. Obsługa wyjścia.

EP12/20124.2 – Dzwonek do 
drzwi. Obsługa wejścia.

4.3 – Obsługa wy-
świetlacza LCD.

Obsługa wyświetlacza alfanumerycznego 2×16 
ze sterownikiem Hitachi HD44780

5 Konfi guracja układu 
Watchdog.

Moduł Watchdog Timer 
w  trybie pracy restar-
tu, oraz zegara.

5.1 – Symulator latarni 
morskiej. Układ Watchdog w  trybie restartu.

EP01/2013
5.2 – Sekundnik. Układ Watchdog w  trybie zegara.

6 Timer w  trybie odmie-
rzania czasu.

Użycie licznika TAR do 
odmierzania czasu.

6.1 – Zegarek elektro-
niczny. Licznik TAR w  trybie pracy „licz do”.

EP02/2013
6.2 – Pozytywka. Licznik TAR w  trybie pracy „ciągłej”.

7 Timer w  trybie wej-
ścia-wyjścia.

Licznik TAR oraz reje-
stry TACCRx w  trybie 
Compare/ Capture 
(porównaj/przechwyć).

7.1 – Generator prze-
biegu prostokątnego.

Licznik TAR i  rejestry TACCRx w  trybie Compa-
re. Generator sygnału  PWM.

EP03/2013
7.2 – Pomiar czasu 
trwania impulsu.

Licznik TAR i  rejestry TACCRx w  trybie Capture. 
Pomiar czasu/częstotliwości  sygnału.

8 Transmisja szeregowa 
UART, SPI.

Obsługa modułu 
kontrolera transmisji 
szeregowej USART.

8.1 – Komunikacja 
mikrokontrolera z  PC. Obsługa interfejsu UART.

EP04/2013
8.2 – Gra zręczno-
ściowa. Obsługa interfejsu SPI.

9 Pomiary analogowe.

Pomiary analogowe 
z  wykorzystaniem 
modułu przetwornika 
ADC10.

9.1 – Termometr 
pokojowy. Obsługa wbudowanego czujnika temperatury.

EP05/20139.2 – Woltomierz 
cyfrowy. Pomiar napięcia na wejściu analogowym.

9.3 – Pomiar zużycia 
baterii. Pomiar napięcia zasilania mikrokontrolera.

10
Obsługa wewnętrznej 
pamięci Flash. Podsu-
mowanie kursu.

Budowa i  działanie 
kontrolera wewnętrznej 
pamięci Flash.

10.1 – Obsługa pamię-
ci Flash. Użycie procedur obsługi pamięci Flash.

EP06/2013
10.2 – Zamek cyfrowy. Odczyt klucza cyfrowego DS1990A.

Zamek cyfrowy
Program „Zamek cyfrowy” uruchamiamy korzystając 
z modułu „Komputerek”. Zworki JP7 i JP8 należy usta-
wić w pozycji LF. Zworkę JP4 (złącze interfejsu 1-Wire) 
należy ustawić w pozycji On. Zworkę JP3 (dioda LED) 
należy ustawić w pozycji LED. Pozostałe zworki ukła-
du należy ustawić w pozycji IO/Off. W  złączu szpil-
kowym Dis1 montujemy wyświetlacz LCD. Natomiast 
w  złączu 1-Wire czytnik pastylek iButton. Wygląd 
zmontowanego modułu „Komputerek” pokazano na 
fotografi i 6.

W pierwszych liniach programu dołączane są bi-
bliotek obsługi interfejsu 1-Wire oraz pastylki iButton 
DS1990A (biblioteki napisane w  języku C). W progra-
mie głównym jest zatrzymywana praca układu Watch-
dog, konfi gurowane linie I/O mikrokontrolera, wyświe-
tlacz LCD oraz sygnały zegarowe. Częstotliwość sy-
gnału zegarowego MCLK jest konfi gurowana na 3 MHz 
(kalibracja wewnętrznego generatora DCO). W progra-
mie sygnał MCLK będzie używany podczas transmisji 
1-Wire. Częstotliwość sygnału musi być stabilna, dla-
tego też w  pętli głównej programu wywoływana jest 
procedura kalibracji sygnału.
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Podsumowanie 
kursu
Przez ostatnie 10 mie-
sięcy publikowaliśmy 
kurs programowania 
MSP430. Przykłady 
prezentowane w  trakcie 
kursu były tworzone 
w  języku C przy uży-
ciu środowiska progra-
mistycznego IAR EW 
(wersja darmowa z ogra-
niczeniem wielkości 
kodu wynikowego pro-
gramu do 4 kB). Platfor-
mą sprzętową kursu był 
moduł „Komputerek” 
z  mikrokontrolerem 
MSP430f1232 (moduł 
można kupić w  sklepie 
AVT, oznaczenie kitu 

to: AVTMSP430/2). W materiałach dodatkowych na 
CD oraz na serwerze FTP zamieszczamy kody źró-
dłowe programów prezentowanych podczas kursu, 
dokumentację techniczną modułu „Komputerek” oraz 
mikrokontrolera MSP430f1232, opis jego rejestrów 
i filmy ilustrujące działanie przykładów. Opis progra-
mów prezentowanych podczas kursu oraz listę odcin-
ków kursu prezentuje tabela 1.

Zainstalowany w  module „Komputerek” mikro-
kontroler MSP430f1232 jest układem z  serii 1xx. 
W  literaturze seria 1xx jest nazywana podstawową/
bazową serią MSP430 i dlatego też do przeprowadze-
nia kursu został wybrany układ z serii 1xx. W prak-
tyce, znając działanie mikrokontrolera z  serii 1xx, 

można „szybko” opanować 
działanie mikrokontrolerów 
MSP430 z  innych, nowszych 
serii. Różnice pomiędzy serią 
1xx, a  seriami 2xx, 4xx, G2xx 
są nieznaczne. Przejście z serii 
1xx na najnowsze układu z se-
rii 5xx/6xx oraz FR5xx (mikro-
kontrolery z  pamięcią FRAM) 
również nie jest kłopotliwe.

Na zakończenie warto do-
dać, że MSP430 to ponad 400 
typów mikrokontrolerów i aż 9 
serii produkcyjnych układów. 
W bogatej ofercie MSP430 moż-
na znaleźć moduły wyposażone 
w  kontroler LCD, interfejs ko-
munikacyjny USB i transceiver 
radiowy RF pracujący w  pa-
śmie ISM do 1 GHz. Nowością 
w  ofercie są mikrokontrolery 
z pamięcią FRAM. Praktycznie 
każdy projekt można zreali-
zować korzystając z  MSP430. 
A  wszystko przy znikomym, 
prawie zerowym poborze ener-
gii!

Łukasz Krysiewicz, EP

W programie głównym, raz na sekundę odczytywa-
ny jest stan linii 1-Wire. Gdy mikrokontroler wykryje 
pastylkę iButton, to odczytywany jest numer identyfi -
kacyjny pastylki. Poprawnie odczytany kod pastylki jest 
wyświetlany na ekranie LCD. Żeby zaprogramować 
zamek, wciskamy przyciski SW1 i SW2, a do czytnika 
przykładamy pastylkę iButton. Odczytany numer iden-
tyfi kacyjny pastylki zostanie zapisany w pamięci Flash 
mikrokontrolera (pamięć informacyjna, segment B). Te-
raz zamek cyfrowy „otworzy się” (stan wysoki na wyj-
ściu przez 0,5 s, włączona dioda LED koloru zielonego 
) skoro tylko zostanie odczytany kod z pastylki, której 
numer identyfi kacyjny został zapisany w pamięci mi-
krokontrolera. Pozostałe pastylki/klucze są ignorowane.

Rysunek 5. Emulatora środowiska IAR. Podgląd a) pamięci Flash b) zmiennych lokalnych

Fotografi a 6. Moduł „Komputerek” w przykładzie „Zamek cyfrowy”
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